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The convention used in this manual to represent actual keys
pressed is to enclose the key label within angle brackets; for
example, <F1>. For key combinations, the key labels are joined
by a + within the angle brackets, for example, <Alt + 2>.

NOTE!
We assume that you are thoroughly familiar with Microsoft
Windows usage and terminology. 
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1.  INTRODUCTION
The GammaVision® Report Writer (A44-BW) transfers information from a GammaVision unfor-
matted output (.UFO) analysis results file to a database, and creates custom reports and spectrum
plots from the database. This program writes to a database so the analysis results can be used
with off-the-shelf applications such as SAP® BusinessObjects Crystal Reports™ or Microsoft
Access®. You can generate reports by selecting either a .UFO (GammaVision analysis results)
file or an existing record in a Report Writer database. GammaVision Report Writer can be run
either automatically from GammaVision or as a standalone program.

Report Writer uses the Crystal Reports engine to generate reports, employing Crystal Reports
macro files as report templates. GammaVision sample analysis (.SDF) files can be set to report
using these templates; and different sample types can use different report templates. 

This release of Report Writer includes two versions of the three default reports.

! GvComplete115.RPT and GvComplete11.RPT, which have similar content to the
default text report for, respectively, GammaVision v7 and GammaVision v6.x and older.
These reports are divided into five sections: (1) a header section which includes the data
acquisition and analysis inputs, (2) an unidentified peak summary, (3) a peak/ energy
matrix containing the identified peaks, (4) a library peak/ usage table, and (5) a summary
of nuclides in the sample. 

! GvActivity115.RPT and GvActivity11.RPT, which present the data acquisition and
analysis inputs, and a summary of nuclides in the sample.

! GvMinimal115.RPT and GvMinimal11.RPT, which report an abbreviated list of data
acquisition and analysis inputs, and the total activity in the sample.

If you are a first-time user of GammaVision and GammaVision Report Writer, use the
version 11.5 templates, which accommodate the new data fields introduced in GammaVision
version 7. If you are upgrading from an earlier version of Report Writer or will report on data
collected with GammaVision v6.x or older, we recommend using the version 11 templates.

You can edit these templates, or create your own, with Crystal Reports v11.5 or Microsoft
Visual Studio® 2010 (not included in A44-BW). See also Section 2.1.1.

Regardless of the template you select for reporting, all of the data described in Chapter 5 is
saved in the database.
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1.1.  If You Have an Older Report Writer Version

If you already have an older version of Report Writer on your computer:

! Any previous report templates will be retained during installation (i.e., they will not be
overwritten). Do not delete older report templates or you will not be able to display your
older reports in the same format as they were originally generated. (You will have to
regenerate them using one of the new templates.) Older templates will be available for
use in addition to the new templates. 

! Your previous Report Writer database, GvRptDB2.mdb, and all its contents will be
retained and updated to the Report Writer v3.10 database format. In addition, your pre-
vious archive database, GvRptArchiveDB2.mdb, and all its contents will be retained
and updated to the v3.10 format.

! Other database files created with previous Report Writer versions will be automatically
updated the next time you connect to them with the Select Database... command
(Section 2.3).

NOTE If you are upgrading from an older version of Report Writer, we strongly recommend
you make a backup copy of all existing database files before installing the new
application.



1Alternatively, you can create a desktop shortcut to Report Writer and follow the same steps to mark its Run as
administrator checkbox.
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2.  INSTALLATION AND STARTUP

2.1.  Installation

You must have Administrator access in Windows to install GammaVision Report Writer.

1) Insert the GammaVision Report Writer CD, navigate to the CD drive, then locate and open
Setup.exe. One or more security dialogs will open. If security dialogs are displayed, choose
the “continue” or “install anyway” option, then the installation wizard will start. Click
Next and move through the wizard screens to completion.

2) The file locations are as follows:

! In 64-bit Windows 7, the GammaVision Report Writer program files are installed in the
\Program Files (x86) folder, and the Crystal Reports program components are stored in
the \Program Files (x86)\Business Objects folder. In 32-bit Windows 7 and in XP,
the Report Writer files are installed in \Program Files and the Crystal Reports
components are in \Program Files\Business Objects.

! The Report Writer database, GvRptDB2.Mdb, is in C:\User.

! The default Crystal Reports templates are in C:\User\Tmpl.

3) For Windows 7 users, the final step is to flag the Start menu entry’s “Run as administrator”
option. This works around a Windows 7 security feature that requires you to connect to data-
base files via the Windows ODBC utility. On the Start menu, locate the GammaVision
Report Writer group, expand it, and right-click the GammaVision Report Writer program
entry. This will open the context menu shown in Fig. 1. Select Properties to open the dialog
shown on the left of Fig. 2. Click the Advanced button to open the dialog on the right of
Fig. 2, click the Run as administrator box, then click OK twice.1

When you Run as administrator, each time you start a Report Writer work session, a
Windows user account security dialog will ask if you wish to allow the program “to make
changes to this computer.” Click Yes. You can then change database files without having to
use the Control Panel ODBC utility until the next Report Writer work session (i.e., it resets
each time you exit Report Writer).

NOTE If you do not use the Run as administrator configuration, Appendix A explains
how to change databases with the Windows ODBC utility.
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Fig. 1.  Select Report Writer Program
Properties.

Fig. 2.  Run As Administrator.

2.1.1.  Creating or Modifying Report Writer Templates

As noted above, the Report Writer templates are standard Crystal Reports that are connected to
the GvRpt Database ODBC data source. To modify or create a new report template you will
need Crystal Reports v11.5 or Microsoft Visual Studio 2010 (not supplied with A44-BW). The
GvComplete115.RPT and GvComplete11.RPT templates closely matches the content and
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Fig. 3.  Report Writer Window at Startup.

layout of the default text report for their respective GammaVision versions, and can be used as
an example to create a custom report. Chapter 5 lists all data available for your custom reports.

NOTE When creating or modifying a template in the Crystal Reports program, make sure
that the Save data with file command on the File menu is not checkmarked. (Note
that this command is only displayed when a template file is being edited.)

2.2.  Startup

From the Windows Start menu, enter   gam   in the “Search programs and files” box, then click
the GammaVision Report Writer search result; or open the Windows Start menu and click
GammaVision Report Writer, then GammaVision Report Writer. Windows 7 users running
in administrator mode (see step [3] in Section 2.1) will see a Windows user account security
dialog. Click Yes to give Report Writer permission to make changes on this computer.

The Report Writer window will
open (Fig. 3). If Report Writer
cannot connect to the most
recently selected database — for
example, on first startup or if the
database file has been moved,
renamed, or deleted — the
Analysis Database Definition
dialog (Fig. 4) will immediately
open and you must connect to a
database file as described in the
next section.

2.3.  Selecting (Connecting to) the Report Database

On the Database menu, click Define... to open the Analysis Database Definition dialog, shown
in Fig. 4. This dialog lets you select an existing database file or create a new database to be used
for analysis reports.

Note the diagram at the top of the dialog depicting a cable connection between the “Report” and
the “Database.” Under normal conditions, the “plug” on the cable is shown as being connected,
indicating the database is connected to the Report Writer program ( ). 



GammaVision® Report Writer v3.1 (A44-BW) 774810K / 0914

6

Fig. 4.  The Database/Report Connection.

Fig. 5.  The Select Database Dialog.

If Report Writer cannot connect to the Current Database for any reason, the “plug” is shown as
disconnected ( ) and you must connect to a valid database file as follows.

NOTE The Report Writer can only connect to a database file created with the Create Data-
base command in this dialog (see the instructions in Section 3.3.1.2). The default
database is GvRptDB2.mdb. However, you may create as many databases as you
wish.

2.3.1.  Windows 7 (“Run as administrator” marked) and Windows XP

Click the Select Database
button to open the Select
Database dialog (Fig. 5).
To complete the connection,
double-click the desired
file or click to highlight it
then click Open. You are
ready to begin generating
reports.            
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2.3.2.  Windows 7 (“Run as administrator” NOT marked)

If you do not run Report Writer in the Run as administrator configuration described in
Section 2.1, clicking the Select Database button will display a permission error instructing you
to connect to the database via the Windows ODBC utility. You can do this without exiting the
Report Writer program, as described in Appendix A.
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[Intentionally blank]
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Fig. 6.  File Menu.

Fig. 7.  The Recall UFO File Dialog.

3.  MENU COMMANDS
This chapter describes the menu commands and accelerators for the GammaVision Report
Writer.

3.1.  File Menu

The File menu (see Fig. 6) contains commands for opening
.UFO files, printing, and plotting; as well as exiting the
program.                       

3.1.1.  Recall UFO...

This menu command lets you select a .UFO file and creates a
report for it using the previously selected template. Figure 7
shows the file-selection dialog and Fig. 8 shows the resulting
report/plot window.

When you click the Open button,
the .UFO record is stored in the
database, and the report and/ or
plot is generated according to
the current report options (see
Section 3.2). Note that duplicate
.UFO filenames replace the old
database entry with the new one.
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Fig. 8.  Report and Plot for the .UFO File.

3.1.2.  Print Report...

This menu command uses the default printer to print the report currently displayed in the report
window. This command is available only when a report window (Fig. 9) is open.
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Fig. 9.  Report Window.

3.1.3.  Print Plot...

This command prints the plot currently displayed in the plot window. A standard print dialog box
is displayed so you can set the printer options. This command is available only when a plot
window (Fig. 10) is open. 
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Fig. 10.  Plot Window.

3.1.4.  Export...

This command exports a report based on the current Export Report As format on the Options
tab under Settings/Report (Section 3.2.1.1).

3.1.5.  Exit

This menu command closes the Report Writer program.
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Fig. 11.  Options
Menu.

Fig. 12.  The Report Tab.

3.2.  Options Menu

The Options menu (Fig. 11) contains commands for setting plot,
report, and program options.

3.2.1.  Settings

This menu command displays a dialog box (see Fig. 12) that
contains options for the report, plot, and database sections. 

3.2.1.1.  Report

Clicking the Report tab in the
upper left of the dialog displays a
property page with the following
options. 

Template

This is the template used to create
the report. Enter the complete name
or use Browse to find the template.
This is the default name, if no name
is given on the command line. 

The Report Writer program inter-
acts with the GammaVision Sam-
ple Type and Report Generator
functions. The report template
selected here is used in Gamma-Vision when the Report Generator command is issued. It also
then becomes the default Report Writer template on the Report tab under Sample Type.

If a different template is selected in GammaVision, using the Report Generator command’s
Setup option, that template is communicated back to the Template field on the Report Writer’s
Report tab. 

Note, however, that GammaVision’s Sample Type Report tab does not communicate with the
Report Writer or the Report Generator command. If you choose a different template on the
Sample Type Report tab, it will be used only for the GammaVision analysis report.
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Fig. 13.  The Plot Tab.

Report Destination

The report is created by default in the same folder as the .UFO file. Alternatively, you can
specify a different target folder. This option lets you store the reports on remote machines (i.e.,
network directories). 

Options

! Export File — The output report can be exported to one of several different formats
discussed in the following paragraph.

! Print Plot with Report — Mark this checkbox to include the plot with the report when
the report is printed.

! Print on Completion — Mark this checkbox to automatically print the report after it is
created.

Export Report As

If the Export File box is checked, the report is saved in the file format specified in this section.
The default is Rich Text format (.RTF). Other formats include Microsoft Word and Excel, and
Portable Document format (.PDF).

3.2.1.2.  Plot

Clicking the Plot tab displays the
property page shown in Fig. 13. It
contains the following options.

Plot Title — An optional title can
be entered for the plot. This replaces
the default title if left blank. The
default plot title is composed of the
spectrum filename and the .ROI file
name. 

Colors... — Clicking this button
displays the Color Options dialog
(see Fig. 14). It allows you to select
specific colors for grid and tic
marks, spectrum data, ROI boxes or
fill, axis labels, and descriptive text. 
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Fig. 14.  The Color Options
Dialog.

Fig. 15.  Horizontal Range.
Fig. 16.  Choose the Vertical Range.

ROI — This section governs the fill mode for areas marked
as ROIs. In Boxed mode, each ROI is marked with a box. The
box is as wide as the ROI and about 75% of the plot height.
In Filled mode, each ROI is drawn as a striped area extending
from the spectrum to the baseline.

Text — The Axis Labels and/or Description text can either
be printed or suppressed.

Horizontal — This section contains two radio buttons that
allow you to specify the horizontal axis in Channels or
Energy. Energy is not available if the spectrum is not cali-
brated. Tic Marks and/or Grid Lines can be displayed for
this axis by marking one or both of the checkboxes. The
grid lines change as the horizontal axis is expanded or contracted.

To select a horizontal range, mark Full Scale or click Range... to choose a specific range (in
channels or energy). Clicking Range... displays the Horizontal Range Options dialog shown in
Fig. 15. The range options need not be the same as the plot options; that is, the range can be in
channels with the plot in energy.

Vertical — This section contains two radio buttons that allow you to specify the vertical axis as
Logarithmic or Linear. Tic Marks and/or Grid Lines can be displayed for this axis by marking
one or both of the checkboxes. The grid lines change as the vertical axis is expanded or con-
tracted; the baseline is always zero.

Mark Auto Scale for automatic scaling, or click Range... to choose a specific range on the
Vertical Range Options dialog, shown in Fig. 16.



GammaVision® Report Writer v3.1 (A44-BW) 774810K / 0914

16

Fig. 17.  The Database Tab.

Fig. 18.  Database Menu.

3.2.1.3.  Database

Clicking the Database tab displays the property page shown in Fig. 17. It allows you to include
the identified and/or unidentified peaks in the database. (Note that this could add a large number
of fields to the database.) The peak lists are useful for making reports on specific peaks.

3.2.2.  Always On Top

When this option is enabled (click to checkmark it on the menu), the Report Writer is always
displayed on top of other windows.

3.3.  Database Menu

The Database menu, shown in Fig. 18, contains commands for
database configuration and maintenance. 

3.3.1.  Define...

The Define... menu command displays the Analysis Database
Definition dialog, shown in Fig. 19. This lets you select or
create a database file to be used for analysis results.
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Fig. 19.  The Database/Report Connection.

Note the diagram at the top of the
dialog depicting a cable connection
between the “Report” and the “Data-
base.” Under normal conditions, the
“plug” on the cable is shown as being
connected, indicating the database is
connected to the Report Writer pro-
gram ( ). If Report Writer can-
not connect to the Current Data-
base for any reason, the plug is
shown as disconnected ( ) and
you must connect to a valid database file.

NOTE The Report Writer can only connect to a database file created with the Create Data-
base command in this dialog.

3.3.1.1.  Select Database...

Selecting (connecting to) a database is discussed in Section 2.3. As noted there, the steps for
selecting a database in Windows 7 depend on whether or not you are running Report Writer in
the “Run as administrator” mode, as configured in step (3) of Section 2.1. Note that Report
Writer can only connect to database files created with the Create Database command described
in the next section.

3.3.1.2.  Create Database...

This button opens a dialog (see Fig. 20) that lets you create a new database formatted according
to the current Data Source Name. This means that if the current data source is GvRpt Data-

base, the Create Database command will generate a new, empty analysis report database. Simi-
larly, if the data source is GvRpt Archive Database, Create Database will generate a new,
empty records archival database. Be sure to first select the correct data source type with the
Select Database command. You may create as many databases as you wish.

Select the desired location, enter the name you wish to assign the new database in the File name
field, and click Save to return to the Analysis Database Definition dialog. 

The final step is to connect it to the report using the Select Database command as described in
Section 2.3. 
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Fig. 20.  The Create Database Dialog.

3.3.2.  Select Analysis

This menu command displays the dialog shown in Fig. 21, which contains several search and
display options as well as a listing of the analysis records in the current database. 

Because the number of records in the database can become very large, selection criteria such as
date, date range, or spectrum name are provided. When you select a database record and click
OK, a new report and plot are created based on the selected record. 

To search for a subset of records, enter the desired Query Options then click the Query Now
button to search on the set of criteria entered. Any or all of the query options can be specified at
the same time. Options left blank are ignored in the search.

NOTE The displayed list of database entries is not updated until you click the Query Now
button.

3.3.2.1.  Spectrum Name

Enter the Spectrum Name (no extension). The asterisk wildcard ( * )can be used. For example: 
QA* finds all names starting with “QA”, and  *QA*  finds all names with “QA” anywhere in the
name.

3.3.2.2.  Date Range

This selects only spectra where the acquired date is between the From and To dates.



774810K / 0914 3. MENU COMMANDS

19

Fig. 21.  Select an Analysis.

3.3.2.3.  Sample Description

Enter the entire sample description to be selected. To search for a specific word or phrase any-
where in the description, put the asterisk wildcard character ( * ) both before and after the word
or phrase. Do not put a space between the asterisk and the word or phrase unless there is a space
in the description. For example,  *DSPEC*  will find “DSPEC-75" but  *DSPEC  *  will not. 

3.3.2.4.  Detector Description

Enter the entire detector description to be selected. To search for a specific word or phrase any-
where in the description, use the asterisk wildcard character as described in Section 3.3.2.3.

3.3.2.5.  Template

When a selection is highlighted in the list box, the report template name that was used to produce
the original report is shown here. To make a report with a different template, choose a new report
template using the Browse button, then select a template file to be used. The template specified
will be replaced by the template name stored with the selection when a new selection is made.
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3.3.2.6.  Show Description

Choose between showing the Sample description or the Detector description in the list of files. 

3.3.2.7.  Sort by Name

The list of spectra is normally shown in the order the spectra were stored in the database. The list
can also be displayed in alphanumeric or reverse alphanumeric order. Select Ascending for
alphanumeric order and Descending for reverse alphanumeric order. Select neither for chrono-
logical order. The redisplay is done by clicking Query Now, discussed in the next paragraph.

3.3.2.8.  Query Now

This button performs a query based on options from the Query Options box. This must be done
to update the list of spectra shown.

3.3.2.9.  List

The lower section of the dialog shows a list of database entries that have been selected from the
database according to the query settings. The list is only updated when you click Query Now.
The list shows the spectrum file name and the selected description. To select a file from this list,
double-click the name or single-click to highlight it and click Select.

3.3.3.  Archive Files

This opens the Archive Files dialog (see Fig. 22), which allows you to archive the database and,
optionally, a range of supporting files to an archive folder and database. The database is stored
by default. The options include storing the .UFO, .SPC, .ROI, and .RPT files in the same sub-
folder that holds the archive database. The displayed description can be selected from either the
sample or detector description. When you click the Copy Files or Move Files button, the selec-
ted database records and files are copied or moved to the archive database immediately. Note
that there is no “undo” for this operation.

You can create as many archive databases as you wish, and can copy and/or move records as
desired to tailor these databases to your needs. Before using Archive Files, you must create the
archive database(s) and folder(s) you wish to use with the Create Database command (Sec-
tion 3.3.1.2), then connect to the archive database as described in Section 2.3.

3.3.3.1.  Associated Files to Archive

These check boxes indicate whether or not the associated file(s) will be archived. For example, if
GvDemo is selected from the list box and the SPC Files box is checked, the GvDemo.spc file
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Fig. 22.  The Archive Files Dialog.

will also be moved to the archive folder along with a database containing the GvDemo record.
Note the files are erased from the current folder. The template files are only archived if they have
the same name as the analysis files. Common templates are not moved.

3.3.3.2.  Show Description

The Sample option displays the sample description in the selection list box. The Detector option
displays the detector description in the selection list box.

3.3.3.3.  Selection

The Select All button highlights all records in the list box. Deselect All removes the highlight
from all records. Use the mouse plus the <Ctrl> and <Shift> keys to select particular records (as
you would in, for example, Windows Explorer). To choose a contiguous block of records, click
the first record in the block, then hold down the <Shift> key and click the last record. Release
<Shift>. To choose a discontinuous set of records, click the first record, then hold down <Ctrl>
and click each remaining record you want to select. Release <Ctrl>.
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3.3.3.4.  Archive Path

All selected files and records will be moved to the archive database (local or network) listed in
this field. If the archive database already contains records, the current records will be merged in;
the existing records will not be overwritten. 

The default archive database is GvRptArchiveDB2.mdb. As noted in the introduction for this
command, the Report Writer can only archive to a database file created with the Create Data-
base command for the GvRpt Archive Database data source (Section 3.3.1.2). If you wish to
create new archive databases, you must create them before configuring the Archive Files
command.

To select (connect to) a different archive database:

! Windows 7 (in “Run administrator” mode) / Windows XP — Click Browse, then
locate and select the desired archive database.

! Windows 7 (“Run as administrator” disabled) — As detailed in Section 2.3, users of
64-bit Windows 7 must issue the C:\Windows\SYSWOW64\Odbcad32.exe to access
the correct ODBC utility; and 32-bit Windows 7 users must make this connection via the
Windows Control Panel ODBC utility. 

For both versions of Windows 7, on the System DSN tab (Fig. 27 on page 38) be sure to
highlight the GvRpt Archive Database entry (not GvRpt Database) before clicking the
Configure button and selecting the desired archive database. Otherwise you will connect to the
wrong type of database!

3.3.3.5.  Sort Options

The list of records can be displayed by order of date transferred to database (sequential, forward
or reverse), by spectrum name (alphanumeric, ascending or descending), or by specific spectrum
name (the asterisk wildcard [ * ] can be used).

3.3.3.6.  Performing the Archive

To transfer the selected records and/or files to the archive database and folder, click Move Files.
To copy the selected records and/or files to the archive database/folder (leaving the original files
records in the current database/folder), click Copy Files. To exit the dialog without archiving,
click Cancel.
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Fig. 23.  Choose Records and Associated Files to be Purged.

3.3.4.  Purge Files

This menu command displays a dialog, shown in Fig. 23, that allows you to remove analyses
from the existing database. Purge options include removing the database records, .UFO, .SPC,
.ROI, and report template files. When you click the Purge Files button, the selected records are
removed from the database and the associated files are sent to the Windows Recycle Bin or
permanently deleted. 

3.3.4.1.  Associated Files to Purge

These check boxes indicate whether or not to purge the associated .UFO, .SPC, .ROI, and/or
.RPT files from the current folder. For example, if GvDemo is selected from the list box and the
SPC Files box is marked, the GvDemo.spc file will be purged along with the GvDemo data-
base record. Note that the files are purged from the current folder. The template files are only
purged if they have the same name as the analysis files. Common templates are not purged.
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3.3.4.2.  Show Description

The Sample option displays the sample description in the selection list box. The Detector option
displays the detector description in the selection list box.

3.3.4.3.  Selection

The Select All button highlights all records in the list box. Deselect All removes the highlight
from all records.

3.3.4.4.  File Options

Choose Send to the Recycle Bin to move the associated files to the Recycle Bin (database
records are deleted). Choose Delete Files to remove files permanently. 

3.3.4.5.  Sort Options

The list of records can be displayed by order of date transferred to database (sequential, forward
or reverse), by spectrum name (alphanumeric, ascending or descending), or by specific spectrum
name (the asterisk wildcard [ * ] can be used).

3.3.4.6.  Purge Files

Click this button to remove the selected database records and either move the associated files to
the recycle bin or delete them.

3.3.4.7.  Cancel

Click this button to exit the dialog without archiving.

3.3.4.8.  List

The lower section of the dialog shows a list of database entries that have been selected from the
database according to the query settings. The list is only updated when you click Query Now.
The list shows the spectrum file name and the selected description. To select a file from this list,
double-click the name, or single-click to highlight it and click Select.
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Fig. 24.  The Window
Menu.

Fig. 25.  The Help Menu.

3.4.  Window Menu

The Window menu (Fig. 24) contains the standard Windows
commands for the open windows within the application; and
shows the windows currently open, if any.

3.5.  Help Menu

The Help menu’s About
command (Fig. 25) provides
version information that may
be needed should you require
technical assistance. 
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4.  AUTOMATIC (COMMAND LINE) MODE
This section describes the command line options for the GammaVision Report Writer. It is run in
this mode from GammaVision or any other program:

GVRPT32.EXE <UFO_File> -C -P -E -T <Template Name>

where:

<UFO_File> The full path name of the .UFO file. There is no default.

-C Specifies “Configure Mode,” where it displays only the property
pages. The default is normal mode.

-P Specifies “Process and Exit” mode. This switch causes the Report
Writer to store the results in the database and silently apply the
settings defined on the Report page of the Properties dialog. This
includes the printing and exporting options, as well as the report
destination folder. Once the options are complete, the Report Writer
exits. The default is normal mode.

-E Sends any errors to the Error.Log file. The default is to not create
the file.

-T <Template Name> Is the full path of the template to be used. The default is the report
template setting on the Settings dialog (Section 3.2.1.1).
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Table Name Contents

Application GvRptApplication Version information

Analysis GvRptAnalysis One record per analysis

Unknown Peaks GvRptUnPeak Peak records only

Identified Peaks GvRptPeak Peak and nuclide records

Table 1.  Report Writer Database Table.

5.  DATABASE TABLE DEFINITIONS
This section contains the database table definitions for the GammaVision Report Writer. This
database does not replace the .UFO file. Its primary purpose is to provide a specifically chosen
data set(s) to custom report generators such as Crystal Reports. Data stored in the .UFO file but
not used in the reports is not stored in the database.

There are four tables in the database, as shown in Table 1. Three tables contain analysis results
and the fourth contains application-specific data. 

The following sections describe these tables in more detail.

5.1.  Application Table, GvRptApplication

This table contains system-wide information.

Field Name Data Type Description

AppID AutoNumber Internal sequence number

AppName TEXT(64) The name of the application (GammaVision Report Writer) that defined
the database.

AppVers TEXT(64) The version of the application that defined the database.

Laboratory TEXT(80) The laboratory name that appears on the reports. 

RptTemplate TEXT(255) The template name and full path that was used when the report was
generated.
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5.2.  Analysis Table, GvRptAnalysis

This table contains fields common to the analysis.

Field Name Data Type Description

AppID INTEGER Link to application table

AnalysisID AutoNumber Internal sequence number.

AcquiredDate DATE The acquisition date. 

AcquiredTime TIME The acquisition time. 

LiveTime FLOATING The live time in floating point seconds.

RealTime FLOATING The real time in floating point seconds.

SampleDesc TEXT(130) The sample description.

DetDesc TEXT(130) The Detector description.

StartChn INTEGER The starting channel for the analysis.

EndChn INTEGER The ending channel for the analysis.

Sigma INTEGER The standard deviation (or confidence level) for uncertainty (1, 2, or 3). 

RndSumFactor FLOATING The random summing factor for the analysis. 

CorrDate DATE The decay correction date. 

CorrTime TIME The decay correction time. 

AbsorpFactor FLOATING The absorption factor for the analysis. 

PeakAccWidth FLOATING The acceptance width for peaks. 

PeakError FLOATING The peak error cutoff value for the peak search  It is recorded in percent.

MDAType INTEGER The MDA type for the analysis.

BkgCalc INTEGER The background calculation type for the analysis. 

DetID INTEGER The Detector ID used to acquire the data. 

GeoID INTEGER The Geometry ID used for the analysis. 

Weight FLOATING The sample weight. 

Units TEXT(16) The textual description for the unit

UnitsNM FLOATING The units factor numerator.

UnitsDN FLOATING The units factor denominator.

RndErr FLOATING Random error value used for the analysis.

SysErr FLOATING Systemic error value used for the analysis.

TotalAct FLOATING The total activity of the sample. 

AnalysisType INTEGER The analysis type flags. 

AnalysisVer TEXT(16) The analysis version string. 

SpcName TEXT(255) The file name of the spectrum file. 

Lib1Name TEXT(255) The name of the first library file. 
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Lib2Name TEXT(255) The name of the second library file. 

Lib3Name TEXT(255) The name of the third library file. 

PbcName TEXT(255) The file name of the PBC table file. 

CalName TEXT(255) The name of the original calibration file. 

CalDesc TEXT(130) The calibration description text. 

CalEnergyCreD DATE The energy calibration creation date. 

CalEnergyCreT DATE The energy calibration creation time. 

CalEfficiencyCreD DATE The efficiency calibration creation date. 

CalEfficiencyCreT DATE The efficiency calibration creation time. 

CalAfit INTEGER The above-knee efficiency calibration fit type. Note that the interpolative
fit type is not supported in the database.

CalBfit INTEGER The below-knee efficiency calibration fit type  Note that the interpolative
fit type is not supported in the database.

CalKnee FLOATING The Detector knee in keV. 

CalAsig FLOATING The 2-sigma uncertainty (in percent) for the above-knee calibration
efficiency fit. 

CalBsig FLOATING The 2-sigma uncertainty (in percent) for the below-knee calibration
efficiency fit.

CalEInt FLOATING The energy calibration intercept value.

CalESlope FLOATING The energy calibration slope value. 

CalEShape FLOATING The energy calibration quadratic value.

CalFInt FLOATING The FWHM intercept value. 

CalFSlope FLOATING The FWHM slope value. 

CalFShape FLOATING The FWHM quadratic value. 

CalAInt FLOATING The above-knee efficiency vs. energy intercept value. 

CalASlope FLOATING The above-knee efficiency vs. energy slope value. 

CalAShape FLOATING The above-knee efficiency vs. energy quadratic value. 

CalBInt FLOATING The below-knee efficiency vs. energy intercept value. 

CalBSlope FLOATING The below-knee efficiency vs. energy slope value. 

CalBShape FLOATING The below-knee efficiency vs. energy quadratic value. 

CalUnc FLOATING The calibration source uncertainty value. 

CalDiff FLOATING The energy calibration difference value. 

Operator TEXT(64) The operator name that appears on the reports. 

DecAcqFlag INTEGER Decay during acquisition enabled.

PBFlag INTEGER Peaked background correction enabled.

RndSumFlag INTEGER Random summing enabled.

DecCorFlag INTEGER Decay correction enabled.
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GeoFlag INTEGER Geometry correction enabled.

AbsorFlag INTEGER Absorption-curies.

UnitMcFlag INTEGER Units in microcuries.

Gamma3Flag INTEGER Library-based peak stripping.

TempCalEInt FLOATING Temporary energy calibration value.

TempCalESlope FLOATING Temporary energy calibration value.

TempCalEShape FLOATING Temporary energy calibration value.

AbsorIntExtFlag INTEGER Flag is “2" if internal absorption, “4" if external absorption.

AbsorLength   INTEGER Absorber length.

AbsorName TEXT(255) Absorber name.

GeoRefName TEXT(255) Geometry correction reference .UFO file.

EffCalFlag   INTEGER Flag to indicate the spectrum has been efficiency calibrated.

IodineECTime FLOATING Iodine equivalence at current time.

IodineEDTime FLOATING Iodine equivalence at decay time.

AveECTime FLOATING Average energy calculation at current time.

AveEDTime FLOATING Average energy calculation at decay time.

Lib1Path TEXT(255) Full path name of the first library file.

Lib2Path TEXT(255) Full path name of the second library file.

Lib3Path TEXT(255) Full path name of the third library file.

PbcPath TEXT(255) Full path to the PBC table file.

CalPath TEXT(255) Full path to the original calibration file.

AbsorPath TEXT(255) Full path to the absorber file.

GeoRefPath TEXT(255) Full path to the reference .UFO file

FractionLimit FLOATING Percent of gamma rays that must be found to identify an isotope.

UFOName TEXT(255) Name of this .UFO file.

MPCFlag INTEGER Flag indicating state of the MPC/DAC table.

AnalysisPgm TEXT(32) AN3REC: Analysis program name

SearchSens Integer CALREC: Peak Search Sensitivity

ColStart Date Date/Time ACQINF: Collection Start date

ColStartTime Date/Time ACQINF: Collection Start time

ColEndDate Date/Time ACQINF: Collection End date

ColEndTime Date/Time ACQINF: Collection End time

PeakUncAbove Double DATREC: Peak uncertainty above the knee

PeakUncBelow Double DATREC: Peak uncertainty below the knee

HalfLives Double ANEXT1: Half-lives decay limit

ActRange Double ANEXT1: Activity range factor
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StepEnergy Double ANEXT1: Minimum step background energy

MDA2 Integer ANEXT1: Second MDA

WeightUnc Double ANEXT1: Sample weight uncertainty in percent

PBCWidth Double ANEXT1: PBC Match Width

EdfBkgName Text(255) EDFREC: Background spectrum name

EdfCsName Text(255) EDFREC: Cesium spectrum name

EdfGeomName Text(255) EDFREC: Geometry file name

EdfBkgPath Text(255) EDFREC: Background spectrum path

EdfCsPath Text(255) EDFREC: Cesium spectrum path

EdfGeomPath Text(255) EDFREC: Geometry file path

EdfLow Double EDFREC: Low integration limit (keV)

EdfHigh Double EDFREC: High integration limit (keV)

EdfFlags Integer EDFREC: Report and calculation flags

EdfGeSeq Integer EDFREC: Germanium sequence number

EdfGtSeq Integer EDFREC: Gamma Total sequence number

ActConv Double EDFDAT: Activity conversion factor

Cs137Eff Double EDFDAT: Cesium Efficiency at 662 keV

EdfGrossCnts Long EDFDAT: EDF sample gross counts

GammaTotalBq Double EDFDAT: Gamma Total in Bq

EdfBkgCPS Double EDFDAT: Background CPS from background spectrum

EdfBkgCnts Long EDFDAT: EDF sample background counts

KFactor Double EDFDAT: K calculation from Cs spectrum

CsGrossCnts Long EDFDAT: EDF gross counts from Cs spectrum

CsBkgCnts Long EDFDAT: EDF background counts from Cs spectrum

CsActBq Double EDFDAT: 662 keV activity in Bq from Cs spectrum

CsPeakArea Double EDFDAT: 662 keV area from Cs spectrum

UncName1 TEXT(38) UNCREC: User defined uncertainty name 1

UncName2 TEXT(38) UNCREC: User defined uncertainty name 2

UncName3 TEXT(38) UNCREC: User defined uncertainty name 3

UncName4 TEXT(38) UNCREC: User defined uncertainty name 4

UncName5 TEXT(38) UNCREC: User defined uncertainty name 5

UncName6 TEXT(38) UNCREC: User defined uncertainty name 6

UncName7 TEXT(38) UNCREC: User defined uncertainty name 7

UncName8 TEXT(38) UNCREC: User defined uncertainty name 8

UncName9 TEXT(38) UNCREC: User defined uncertainty name 9

UncVal1 Double UNCREC: User defined uncertainty value 1
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UncVal2 Double UNCREC: User defined uncertainty value 2

UncVal3 Double UNCREC: User defined uncertainty value 3

UncVal4 Double UNCREC: User defined uncertainty value 4

UncVal5 Double UNCREC: User defined uncertainty value 5

UncVal6 Double UNCREC: User defined uncertainty value 6

UncVal7 Double UNCREC: User defined uncertainty value 7

UncVal8 Double UNCREC: User defined uncertainty value 8

UncVal9 Double UNCREC: User defined uncertainty value 9

5.3.  Identified Peaks Table, GvRptPeak

This table contains the list of identified peaks.

Field Name Data Type Description

AnalysisID INTEGER Link to analysis table.

PeakID AutoNumber Internal sequence number.

PeakNum INTEGER Contains the one-based peak number.

Channel FLOATING The peak centroid in channels. 

Energy FLOATING The peak energy in channels. 

BkgCnt FLOATING The corrected background for the peak. 

NetCnt FLOATING The corrected net area of the peak. 

Uncertainty FLOATING The peak counting uncertainty. 

FWHM FLOATING The full width at half maximum in keV. 

FW10M FLOATING The full width at 0.10 maximum in keV. 

FW04M FLOATING The full width at 0.04 maximum in keV. 

Flag1 INTEGER The first set of peak flags. 

Flag2 INTEGER The second set of peak flags. 

Flag3 INTEGER The third set of peak flags. 

RoiLow INTEGER The peak low limit of integration. 

RoiHigh INTEGER The peak high limit of integration. 

LibNum INTEGER The library index number from which the nuclide information was
obtained. For example, a 1 indicates that the library information came
from the first library file (field Lib1Path in the Analysis Table).

Gammas FLOATING The gammas per 100 disintegration. 

MDA FLOATING The MDA based on this peak. 

Abundance FLOATING The isotopic abundance based on this peak. 
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Nuclide TEXT(10) The nuclide name. 

LibEnergy FLOATING The library energy for this peak.

HalfLife FLOATING The nuclide half life in days. 

PBCFactor FLOATING The PBC correction factor. 

Nflag INTEGER The nuclide analysis flags.

NucAbun FLOATING The calculated abundance of the nuclide in becquerels.

Hfactor FLOATING The decay time correction factor. 

IsoError FLOATING The isotope counting error for this nuclide. 

TotalError FLOATING The total error for this nuclide. 

IsoMDA FLOATING The isotope MDA for this nuclide. 

PKFlag INTEGER Information about the library peak record. 

PKPrevious INTEGER The number of the previous peak record. This is used for formatting the
report.

MPCVAL FLOATING MPC or DAC value for this isotope.

NuclideCode INTEGER Nuclide code flags.

PeakCode INTEGER Peak type code flags.

LibraryUsed INTEGER Which library was used 1, 2, or 3.

MDA2 FLOATING The second MDA based on this peak.

Pkunact FLOATING Counting uncertainty in Bq.

ErrorBq FLOATING Isotope counting error in Bq.

TotalErrorBq FLOATING Total error in Bq.

Flag4 Integer Fourth set of peak flags

IsoMDA2 Double Second MDA value

IsoNormMDA Double ISO NORM MDA for this isotope

Brunct Double Branching ratio uncertainty

Acl Double ISO NORM: critical level

Amda Double ISO NORM: MDA

Ahat Double ISO NORM: Best estimated activity

Alow Double ISO NORM: Lower confidence interval

Ahigh Double ISO NORM: Upper confidence interval

Uhat Double ISO NORM: Uncertainty of Ahat

ConvUnc Double ISO NORM: Uncertainty of conversion factor

BetaError Double ISO NORM: Beta error (Type II)
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5.4.  Unknown Peaks Table, GvRptUnPeak

This table contains the list of unknown peaks.

Field Name Data Type Description

AnalysisID INTEGER Link to analysis table.

UnPeakID AutoNumber Internal sequence number.

PeakNum INTEGER Contains the one-based peak.

Channel FLOATING The peak centroid in channels. 

Energy FLOATING The peak energy in channels. 

BkgCnt FLOATING The corrected background for the peak. 

NetCnt FLOATING The corrected net area of the peak. 

Uncertainty FLOATING The peak counting uncertainty. 

FWHM FLOATING The full width at half maximum in keV. 

FW10M FLOATING The full width at 0.10 maximum in keV. 

FW04M FLOATING The full width at 0.04 maximum in keV. 

Flag1 INTEGER The first set of peak flags. 

Flag2 INTEGER The second set of peak flags. 

Flag3 INTEGER The third set of peak flags. 

RoiLow INTEGER The peak low limit of integration. 

RoiHigh INTEGER The peak high limit of integration. 

SuspectPeak TEXT(10) The suspected nuclide name for current energy.

Flag4 INTEGER Fourth set of peak flags.
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Fig. 26.  Run Obdcad32.exe in
64-Bit Windows 7.

APPENDIX A.  CHANGING DATABASES WITH
THE WINDOWS ODBC UTILITY

If for some reason you cannot run GammaVision Report Writer in administrator mode, clicking
the Select Database button will display a permission error instructing you to connect to the data-
base via the Windows ODBC utility. You can do this without exiting the Report Writer program.

1) Close the message and the Select Database dialog.

2) Accessing the proper ODBC utility is different for 64-bit Windows 7 vs. 32-bit Windows 7:

! 64-bit Windows 7:  Enter the following executable filename in the “search programs

and files” box (Fig. 26) and press <Enter> to open the ODBC Data Source Admini-
strator dialog used by Report Writer:

C:\Windows\SYSWOW64\Odbcad32.exe

! 32-bit Windows 7:  From the Windows Control Panel, select ODBC to open the ODBC
Data Source Administrator dialog. 

3) Click the System DSN tab (Fig. 27).

4) Click to highlight the GvRpt Database entry, then click the Configure button. This will
open the dialog shown in Fig. 28.

5) Click the Select button to open the file-open dialog shown in Fig. 29. Select the desired
database file and click OK, then click OK as needed to return to the Control Panel.
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Fig. 27.  System DSN Tab.

Fig. 28.  Click Select to Choose a Database File.

Fig. 29.  Select the Target Database File.

6) At this point, return to the Report Writer window and begin generating reports.
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